Exploring the world of virtual reality gaming
with Google Cardboard and Unity

Samartha S M, Ritvik S Kotwal and Vidyashri V Mutnal
1,2,3 Computer Science and Engineering, The National Institute of Engineering
[Under the guidance of Ms. V. K Annapurna, Associate Professor, Dept. of CS & E, NIE, Mysore]

Abstract - Combining digital construction of virtual environments with mobile technologies has the potential of enriching user's gaming experience. Through designing a virtual reality mobile gaming application with Google Cardboard, it is possible to use the technology already in peoples’ pockets to provide an actual virtual reality gaming experience to the user.

This paper looks at our experience in developing such a mobile application, named "Trouver", wherein the players will be in interaction with a created virtual environment, finding and tapping various game objects to complete the game. The game is about finding a missing element from a created virtual environment and the player slides, ducks and turns in every direction, to explore and find the element.

The application brings together traditional media such as 3D images with a mobile Smartphone and a Google Cardboard to provide a comprehensive and a verisimilitude gaming experience. The mobile application is available for most of the android devices, delivering it to a large number potential audience. The application draws inspiration from various other Cardboard-specific applications such as the Lanterns application, the Google Street View application, The 360º video channel in the YouTube application and many more. In the absence of Google Cardboard the App is still useful providing a VR gaming experience to the user, where the user interaction with the game objects is made available by a tap and touch mechanism.

Keywords - Virtual Reality, VR gaming, Google Cardboard, Cardboard Gaming, Unity, Unity game development, Android.

I. INTRODUCTION

Virtual Reality (VR), referred to as immersive multimedia, is a computer simulated environment that can simulate physical presence in places in the real world or imagined worlds. Virtual Reality can recreate sensory experiences, which include virtual taste, sight, smell, sound and touch. Virtual reality is often used to describe a wide variety of applications commonly associated with immersive, highly visual, 3D environments.

Most up-to-date virtual realities are displayed either on a computer screen or with a special virtual reality headset (also called head mounted display), and some simulations include additional sensory information and focus on real sound through speakers or headphones targeted towards VR users. Virtual reality covers remote communication environments which provide virtual presence of users with the concepts of telepresence and telexistence or a virtual artifact (VA) either through the use of standard input devices such as a keyboard and mouse, or through multimodal devices such as a wired glove or omnidirectional treadmills. The immersive environment can be similar to the real world in order to create a lifelike experience- for example, in
simulations for pilot or combat training—or it can differ significantly from reality, such as in VR games.

Trouver is a virtual reality gaming application, where a person can play by interacting with a three-dimensional environment, created using special software. “Trouver”, a French word, basically means “Find”, which is what the game is all about. The game is about finding a missing element from the virtual environment that is created. The user will have to slide, duck and turn around repetitively in circles, to explore and find that element. Once the element is found, the user completes one chapter in the game and hence will be directed to the next levels. Through this game a user can be able to experience virtual environment using a simple head mounted display called Google Cardboard which is of least cost.

II. HISTORY OF VIRTUAL REALITY GAMING

Virtual Reality has been a dominating technology in recent years and has been one of the most exciting technologies for the Game Developers to work with. However, this isn't virtual reality's first foray into gaming. The format appeared many years ago, setting the stage for today's technology. That said, here’s a brief look at VR’s humble beginnings.

Sega’s VR-Powered Shades - Sega's Master System 3D glasses appeared in the 80s, a flickering headset that recreated the effect of 3D in a private setting. Though primitive, compared to today's 3D standards, it created a unique effect across different games, including Space Harrier, Maze Hunter, Zaxxon 3D and Missile Defense.

The headset didn't sell as well as Sega had hoped, but the 3D trend came back when Sony introduced a more casual model with certain PlayStation 3 games, including Killzone 3, Sly Cooper: Thieves In Time and the Ico/Shadow of the Colossus Collection.

Nintendo's Virtual Boy - In 1995, Nintendo decided to give virtual gaming a try with its 3D red-and-black based headset, the Virtual Boy. After finding success in a rental campaign during the summer, the company launched it at retail for around $180.

Several 3D games were introduced, including Teleroboxer, Red Alert and Mario's Tennis, a brand that jumped to other consoles after its VR debut. It also introduced fans to the Wario Land series, which continues its success on the Virtual Console.

Despite some players feeling queasy from the experience (the red and black display didn't suit everyone), the Virtual Boy introduced some cool ideas before Nintendo discontinued it the following year. The aspect of 3D gaming would stick with the company, eventually returning with the release of the 3DS in 2011.

Arcade VR Units - In the 90s, a company called Virtuality Group looked to introduce players to a one of a kind arcade experience. It did so with the Virtuality cabinets, huge oversized units where players stepped in, placed virtual goggles over their heads and put themselves in a 3D polygonal world.

The arcade unit came with several games, including a special virtual reality version of Pac-Man and a fast-paced game called Zone Hunter, and would eventually lead Virtuality Group to try a home model, powered by Philips Electronics, in 1998. Though highly advanced for the time and fairly priced at $299, it only sold about 55,000 units overall.
The tech turned a few heads, and also inspired the film version of Stephen King's The Lawnmower Man.

The Return of Virtual Reality, Courtesy of Oculus Rift - Virtual reality entered the headlines again when a company called Oculus VR developed a headset called the Oculus Rift. The device first got its start through a successful Kickstarter campaign, and soon after, Oculus began showing off the tech at trade events, where it was well received.

The Oculus' game library will probably be the most telling factor of its success, as it utilizes both original games and popular hits. Games such as Doom 3, Mirror's Edge and Hawken were adapted to take advantage of the headset, and savvy developers created everything from an 8-bit Legend of Zelda game to the horror adventure Dreadhalls. The 3D effect, combined with the comfort of the headset, promises a convenient and affordable experience.

More importantly, it now has support. Facebook paid $2 billion for Oculus and its high-tech Rift gear, but it intends to let the company run on its own, meaning the headset is still on tap for a consumer release a few months down the line. Still, with financial backing now in its corner and increased accessibility, Oculus should have no trouble finding an audience, and making virtual reality popular again.

III. INTRODUCTION OF GOOGLE CARDBOARD

Virtual reality had made exciting progress over the past several years. However, developing for VR still required expensive, specialized hardware. Thinking about how to make VR accessible to more people, a group of VR enthusiasts at Google experimented with using a smartphone to drive VR experiences. The result is Cardboard [7] (shown in Fig 1).

Cardboard is built using a pair of lenses with a 40mm focal distance to keep the phone's screen in focus. The kit also requires magnets, velcro, a rubber band, and an optional NFC tag if the user wants to place his device in the headset to launch the app right away. The magnet and rubber band serve as a makeshift hardware button for your phone, something decidedly analog. Once the kit is assembled, a smartphone is inserted in the back of the device and held in place by the selected fastening device. A Google Cardboard–compatible app splits the smartphone display image into two, one for each eye, while also applying barrel distortion to each image to counter pincushion distortion from the lenses. The result is a stereoscopic ("3D") image with a wide field of view.

![Google Cardboard](image-url)
IV. UNITY GAME ENGINE

Unity is a cross-platform game engine with a built-in IDE developed by Unity Technologies. It is used to develop video games for web plugins, desktop platforms, consoles and mobile devices. First announced only for OS X, at Apple’s Worldwide Developers Conference in 2005, it has since been extended to target twenty one platforms. It is the default software development kit (SDK) for the Wii U.

IDE stands for Integrated Development Environment: Unity actually is the union of a game engine, that allows game created to run (hence to be played) in different environments, an application where the “visible pieces” of a game can be put together (the IDE) with a graphical preview and using a controlled “play it” function, and a code editor.

Once, the user has the game design and all the required skills to put together varied graphics, sounds, animations in Unity’s IDE, the codes are written associated to the assets and then a playable application that runs in several different environments is generated. One of the features of Unity is that it is multi-platform, which is more or less the same game can run similarly on an iPad or on Android device.

V. TROUVER APPLICATION

To provide a low-cost VR experience to the users, a mobile gaming application was developed to take advantage of the Unity game engine and increasing power of mobile technologies. To provide an engaging experience, the Google Cardboard [1] (shown in Fig 3) was leveraged to produce a light-weight, virtual reality system - an app that provides an immersive experience without the encumbrances and cost implications of venerable VR headsets like the Oculus Rift.

Trouver is a virtual reality gaming application, where a person can play by interacting with a three-dimensional environment, created using special software. “Trouver”, a French word, basically means “Find”, which is what the game is all about. The game is about finding a missing element from the virtual environment that is created. The user can slide, duck and turn, to explore and find that element. Once the element is found, the user completes one chapter in the game and hence will be directed to the next levels.

![Google Cardboard](image-url)

Figure 2: Google Cardboard. Source: [1]

Trouver is a virtual reality gaming application, where a person can play by interacting with a three-dimensional environment, created using special software. “Trouver”, a French word, basically means “Find”, which is what the game is all about. The game is about finding a missing element from the virtual environment that is created. The user can slide, duck and turn, to explore and find that element. Once the element is found, the user completes one chapter in the game and hence will be directed to the next levels.
The highlights the main features of the system and how these features contribute to the user experience are as follows:

1. **3D objects**: Embedded within each level environment are 3D objects (or hotspots) which can be triggered to perform actions such as navigating to a new location, launching a stereoscopic video or launching a popup with more information.

2. **VR mode switch**: The VR mode switches from the Cardboard mode to the VR mode. The screen splits in the Cardboard mode and stays non-split in the normal Virtual Reality mode.

3. **Game Pointer movement and presence on the game objects**: The pointer moves with the player’s movements and the selectable game objects change their color to reflect the pointer’s presence when the pointer points on them.

4. **Game Object Selection**: The player selects the game objects, by pointing on the game objects and pulling the magnet, in the Cardboard mode and by tapping on the game objects in the VR mode. The game objects get selected and disappears from the game scene.

For the development, the game is divided into three modules and they are detailed as follows:

1. **VR game environment**:
   - This module is used to develop the virtual environment around the user.
   - Using the different objects, assets and components, the desired virtual environment is created in Unity 3d game engine.

   Examples of different environment elements used for the environment are terrains (trees, grass, and water), skyboxes, lens flares, fog, etc.

   Steps in building the game environment

   - The Unity 3d game engine is opened, a new project is selected by giving a suitable name for the project and the desired game type is selected i.e., 3D or 2D.
   - The required objects, assets and terrains are imported.
   - Once all the object are set and the environment is created, the whole scene is viewed in the game view by clicking on the play and pause icons in Unity.

   Pictorial representation of the steps involved in building the game environment is shown in Figures 3, 4 and 5 (in order):

   ![Figure 3: New project selection](image-url)
VR game objects behavior:
This module is used to define the behaviors of the various game objects in the game environment.

Using the different assets and scripts, the desired behaviors of the game objects are defined in Unity 3d game engine.

Examples of code scripts defining the object behaviors are

- First Person Controller (FPS) - Script to control the movement of the camera, it’s gravity and the speed of its motion.

- Third Person Controller (TPC) - Script to control a game object in the game. This contains scripts such as aicontroller.cc, thirdpersoncharacter.cc and thirdpersoncontroller.cc. These scripts contain c# codes for controlling the movement of the game object in the environment built.
Steps in defining the game objects behavior

- The desired virtual environment is established.
- The required objects, assets and terrains are imported.
- Components are attached to objects and scripts are written, specifying the functionality of the objects in scene.
- Once all the object functionalities are set, the whole scene is viewed in the game view by clicking on the play and pause icons in Unity.

Pictorial representation of the steps involved in defining the game objects behavior is shown in Figures 6 and 7 (in order):

![Figure 6: Scripts attachment to game objects](image1)

![Figure 7: Objects behavior established](image2)

(3) VR game file build:
This module is used to build the game application file using the Unity 3d game engine.
Using the Java and Android Development Kits i.e., JDKs and ADKs, the mobile runnable application file (.apk file) is created.

Steps in building the game application file

- Go to Edit > Preferences > External Tools > Select the root folders of SDK and JDK in the popped up window.
- Go to File > Build Settings > Select the desired platform > Click on Build to complete the process.

Pictorial representation of the steps involved in building the game application file is shown in Figures 8 and 9 (in order):

![Figure 8: SDK and JDK root folder selection](image1)

![Figure 9: Application file built](image2)
VI. CONCLUSION

Several works exist in the field of virtual reality to provide a lifelike virtual experience to the user. The combination of a Smartphone and a lightweight virtual reality headset like the Google Cardboard opens up new possibilities for providing a virtual verisimilitude gaming experience and provides an improved user experience, by tackling some of the challenges that have been uncovered in previous works.

In addition, the enclosure of the Smartphone in the VR headset provides a level of immersion that may not be available when viewing objects on a device’s screen.

Furthermore, it makes the system well-suited for playing even in outdoor environments, as the casing serves an additional function of eliminating any glare (from the sun) that hampers vision; an issue which may arise when viewing objects on a screen outdoors.

All in all, a new age Google Cardboard gaming application is developed where an interactive, three-dimensional virtual world is provided to give a close-to-real game-play and experience.

VII. FUTURE WORK

A desired feature of Trouver gaming application is the ability to render use the complex physical movements of the player. This functionality could be provided by scripting a code script that emulates the Auto-Walk feature, found in similar virtual reality games. Specifically, it would be interesting to add this feature to the higher levels in the game.

Another desired feature would be Automatic selection and opening of the mobile application, when the phone is placed inside the enclosure of the Cardboard headset. This feature could be made possible by using a Near Field Communication or NFC Tag. An NFC tag could be set with the task of selecting the application and the same tag could be stuck in the Cardboard enclosure.

Different modalities can be implemented, such as switching between the real world and virtual world views, augmenting the real world view with virtual world content (or vice versa).

REFERENCES


